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Introduction

Google’s Android Operating System continues to gain market share, making it one of the most often 
utilized OSes internationally. Android currently powers everything from smartwatches to iTV sets to 
smartphones to smartglasses to touchscreen tablets to e-book readers to game consoles and now 
homes, appliances, audio products, car dashboards, and more. 

One of the most important design considerations for any Android application is the UI Design (User 
Interface Design), as this defines how the Android application user interfaces with the objective of 
the application itself. An Android application that features a streamlined, simple, and elegant UI 
Design will please users and enhance sales volumes within the Android applications marketplace.

The Android OS contains a plethora of UI Design classes that have been specifically created to help 
Android developers implement creative UI designs, as well as to conform their UI Design to Android 
OS UI Design standards. This book covers those primary UI Layout Container classes and methods, 
as well as all the Android UI Design standards and guidelines, which every Android developer should 
understand and follow in their application design work process.

I wrote Pro Android UI to help readers delve into the inner workings of the Android UI Design 
standards, to explore the most popular UI layout classes and methods, and to be a complimentary 
title to my recent Pro Android Graphics title. Pro Android UI targets those readers who are already 
technically proficient, that is, those who are familiar with computer programming concepts and 
techniques. This title covers the latest Android 4.x Operating System revisions (4.0, 4.1.2, 4.2.2, 
4.3.1, and 4.4.2), as well as covering earlier Android OS versions.

This book also covers the usage of a wide variety of related open source software packages that can 
be used in the Android application development work process. Such packages include seasoned 
open source new media applications like GIMP, Lightworks, Pencil, Blender, and Audacity. We take a 
look at how the usage of these packages fits into the overall Android application development work 
process. We also take a look at new media elements and supported formats, how they work, and 
how to leverage them in your UI Design process.

Using a multiple open source software package implementation approach will serve to set Pro 
Android UI distinctly apart from the other Android user interface design titles currently on the market. 
This book starts out with the reader installing the latest Java SE and Android SDKs using the Eclipse 
Kepler IDE, with the Android ADT Bundle, and then many of the most popular open source new 
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media production applications for digital imaging, digital audio editing, digital video production, user 
interface wireframing and prototyping, and more.

The book then progresses through creating Menu UI Designs, ActionBar UI Designs, Android UI 
Rules and Guidelines, and then finally through the primary types of UI Layout Containers that 
developers specifically implement for their Android application UI Design.

We look at static user interface design using XML mark-up, dynamic user interface design using 
Java, using digital imaging within your user interface design, using digital video and animation in 
your user interface design, Android OS user interface design rules and standards , as well as other 
advanced new media concepts and multimedia application features that are currently popular in 
Android UI Design for Android application development.

We look at the core Android UI Design areas, including UI layout containers, UI widgets, ActionBar UI 
Design, New Media formats, codecs, concepts and implementations, and advanced concepts such 
as Fragments, all in fine detail. If you want to get an overview of and a handle on Android UI Design, 
this title is a great place to start that process.
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Introduction to the Core 
Classes for Android UI Design: 
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Chapter 1
Android UI Design Tools: Setting 
Up Your Android Development 
System

In this first chapter, we will set-up your Android Application Development workstation. I recommend 
using at least a hexa-core Intel or AMD 64-bit PC with 64-bit Windows 8.1 (or at least Windows 7) 
operating system installed on this workstation, preferable using an SSD (Solid State Drive) for your 
primary C:\ disk drive. An SSD will provide your workstation with a vastly accelerated overall system 
performance, especially at software load-time.

Fortunately, you can get a hexa-core (or octa-core) online at PriceWatch, or walk into Walmart and 
pick one up for just a few hundred dollars. Then, simply install all this open source software that I am 
going to expose you to in this chapter, which is worth thousands (actually, it’s priceless if you factor 
in the power that it gives you), and you can then create or develop anything that you can imagine—
right out of thin air.

For those readers who have just purchased their new Pro Android UI Design workstation, and who 
are going to put an entire development software suite together from scratch, I will go through this 
entire process. Essentially, these are  the steps that I would go through to put together a powerful UI 
development workstation from scratch with zero expenditure on software.

The first objective is to get the entire Oracle Java software development kit (SDK), which Oracle 
currently calls JavaSE 6u45 JDK (Java Development Kit). Android uses Java Version 6u45, as of 
Android 4.4, but there is also a Java Version 7u45, and later on this year there will be a Java Version 
8 released, which will contain the powerful JavaFX 2.2.45 new media engine, and so great things are 
coming in the future for Pro Android UI developers!

The second thing that we will download and install is Android’s Developer Tools (ADT) that we get 
from Google’s developer.android.com website.

http://developer.android.com/
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The Android Developer Tools (ADT Bundle) consists of: the Eclipse Kepler 4.4 IDE (Integrated 
Development Environment), along with the ADT plug-ins which accesses the Android 4.4 KitKat 
API Level 19 SDK (Software Development Kit), which is also part of this 480MB ADT Bundle 
download.

After that, we’ll download and install software development tools that we will utilize in conjunction 
with Android for things such as UI wireframing (Pencil), digital image editing (GIMP2), digital audio 
editing (Audacity), digital video editing (Lightworks 11.5) and 3D modeling (Blender 2.69).

All these software development tools which we download and install match the primary feature sets 
of expensive paid software packages, such as those from Microsoft (Visual Studio), Apple (Logic, 
Avid, and Final Cut Pro) and Adobe (Photoshop, Premiere, and After Effects), each of which would 
cost thousands of dollars to purchase.

Java 6: Download and Install the Foundation for Android
The first thing that you want to do is to visit Oracle’s Tech Network Java archives website, which is 
currently located at the following URL:
 
http://www.oracle.com/work/java/javasebusiness/downloads/java-archive-downloads-javase6-419409.html
 
You need to download and install the latest Java 6 JDK environment, which, at the time of writing 
this book is Java SE 6u45, as shown in Figure 1-1.

Figure 1-1. Oracle TechNetwork website Java section, scroll to the middle, to find the Java SE 6 JDK download

http://www.oracle.com/work/java/javasebusiness/downloads/java-archive-downloads-javase6-419409.html
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The URL is also shown in the address bar of Figure 1-1, or, you can simply Google Java 6 SE JDK 
Download Archive 6U45, as shown in the Google tab in the screenshot.

You can see the Java SE Development Kit 6u45 download link for this Java SE 6u45 JDK shown 
at the bottom of Figure 1-1. Make sure to use this JDK download link, and not the JRE 6u45 (Java 
Runtime Edition) download link.

The JRE is that part of Java which “runs” or executes your Java code, once it is compiled into an 
interim “Java ByteStream” format, and this will not allow you to develop Java code, only to run it 
once it has been developed.

To develop the Java (and thus Android, which uses Java) program logic for your applications, you 
will need to download the JDK, as well as the JRE.

Fortunately, the JDK download also includes the JRE, which is logical, as it would be needed as part 
of the development and testing work process.

The reason the JRE is also available separately is that others who want to run your Java apps will 
need the JRE installed on their system, but do not need the entire JDK, as they are not developers.

Make sure not to download the JDK 7u45 JDK or the Java7u45 Bundle, which includes NetBeans 
8.0, because Android uses the Eclipse IDE, and not the NetBeans IDE for the ADT plug-ins. 
NetBeans 8.0 is what I use for Java 8 and HTML5 development, but is not currently compatible with 
Android ADT.

Thus, if you see any Java 7 downloads, you are on the wrong webpage, for the current Java 7 (or 
Java 8) downloads, not the Java 6 “archive” page.

The Java 6 version is “archived,” which means that it is still available, but is not the current version. 
Once Google and Oracle settle their legal positions regarding the use of Java in Android, Android 
OS may eventually be upgraded to utilize Java 7 or even Java 8, which would make the JavaFX new 
media engine available to Android developers.

What makes this something to watch out for and also somewhat confusing, is that Oracle made 
the Java 7 update or version numbering parallel with Java 6, so one is Java 6u45 and one is Java 
7u45, making them more similar than they actually are. Java 7 has not had 45 updates, but for some 
reason, the version numbers have been jumped on Java 7 to parallel between the two and will most 
likely remain in sync from now on, so make sure to use JavaSE 6!

Once you click on the Java SE Development Kit 6u45 download link, you will be taken to a JDK6 
Download section shown in Figure 1-2, where you can select the OS you’re using (I’m using 
Windows 8.1 64-bit Windows).
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Once you click the Accept License Agreement radio button, which will be on the top-left of the 
download links table, as seen in Figure 1-2, the links will become bolded and you will be able to 
click on the link that you wish to use. If you are on Windows, and your OS is 64-bit, as my Windows 
8.1 OS is, then use the Windows x64 link, otherwise you would use the Windows x86 link if you 
have Windows XP, a 32-bit OS such as Windows Vista 32-bit, or Windows 7 32-bit or even Windows 
8.1 32-bit.

It is important to use 32-bit versions of Java and Eclipse if your OS is a 32-bit OS version, and 
similarly use a 64-bit version of Java and Eclipse, if your OS is a 64-bit version. An OS that is 64-bit 
can access more than 3GB of system memory. You can find out what your OS version is by dropping 
down your Start menu and right-clicking on the Computer selection and then selecting the 
Properties menu option, located at the bottom of that menu.

Once the installation executable has downloaded, open it, and install the latest Java JDK on your 
system. You can remove any older versions of Java using the Windows Control Panel, and Change 
or Remove Programs utility if your workstation is not new, so only the latest JDK and JRE are 
installed.

Once Java 6u45 (or later) JDK is installed on the workstation you can then download and install the 
Android ADT Bundle from the developer.android.com website. You can use the Change or Remove 
Programs utility in your Control Panel that you used to remove older Java versions to confirm 
installation.

Figure 1-2. Java SE Development Kit 6u45 download links after Accept License Agreement Radio Button clicked

http://developer.android.com/
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Android ADT Bundle: Find and Download Android’s IDE
The second thing that we want to do is to visit the developer.android.com website, and download 
and install the Android Development Environment ADT Bundle ZIP file. On the homepage, click the 
Get the SDK button, on the bottom left of the site, to navigate to this website’s SDK section, which 
is shown in Figure 1-3. The URL for this section of the website can also be seen in Figure 1-3 and 
you can type it in directly as well if you want to:
 
https://developer.android.com/sdk/index.html 

Figure 1-3. The developer.android.com/sdk/websitedownloadpage, and the Download the SDK button, on the right

Once you are on the Get the Android SDK page click the Download the SDK ADT Bundle for 
Windows (a big blue button on the middle-right of the page) to download an ADT Bundle for 
Windows, as is shown in Figure 1-3.

This takes you to the actual downloads page, where you can select your OS bit-level version  
(32-bit or 64-bit) and agree to the terms of the product licensing, as is shown in Figure 1-4.  
Since I’m running the Windows 8.1 64-bit OS, I selected the 64-bit software version radio button.

http://developer.android.com/
https://developer.android.com/sdk/index.html
http://developer.android.com/sdk/%20website%20download%20page
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The actual SDK ADT Bundle downloading page, shown in Figure 1-4, contains a section at the top 
for the end user licensing agreement (EULA) specific to the Android Software Development Kit, 
as well as selections for either a 32-bit or a 64-bit IDE Android software bundle download. Read the 
Terms and Conditions section of this page carefully! If needed, read this with your legal department, 
and then click the checkbox next to the statement at the bottom that reads: I have read and agree 
with the above terms and conditions. This enables the rest of this download page functionality.

Once the checkbox has been activated (checked), you should then can select either the 32-bit or 
the 64-bit version of Eclipse 4.4’s ADT Bundle that is contained inside of a .ZIP format software 
installation package.

If you downloaded the Java 6u45 JDK for Windows x64 or Linux x64 you would select the 64-bit 
version; conversely if you selected Java 6u45 for an x86 OS you would select the 32-bit version of 
this SDK ADT bundle of software.

Once this selection has been made, the actual Download the SDK ADT Bundle blue button will be 
activated and you may click it to begin a download.

Figure 1-4. Android Developer site Get the Android SDK page where you click Download the SDK ADT Bundle for Windows
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Once this 480MB download is complete, which may take a while depending on your Internet 
connection; we’ll unzip the files in a development directory and set-up Android for use on our Pro 
Android UI development workstation.

Android ADT Bundle: Installing the Android IDE
The first thing we need to do after the download is complete is to find the file that we just downloaded, 
which should be in your operating system’s Downloads folder. Usually you can right-click on a 
downloaded file in your browser’s download progress window, and select the View in Folder option.

I downloaded my software on a different workstation, so I copied this file into a Software folder on 
my USB thumbdrive, which is shown in Figure 1-5.

Figure 1-5. Finding the adt-bundle-windows ZIP file in my Software folder, and right-clicking to Extract All

Once you locate either the adt-bundle-windows-x86 (32-bit Windows XP, Win7, or Vista), or the 
adt-bundle-windows-x86_64 (64-bit Windows Vista, Win7 or Win8) ZIP file in your Downloads 
folder, right-click it, and select the Extract All option from the menu, as is shown in Figure 1-5.

Also shown in Figure 1-5 are a number of the software packages that I use, downloaded and installed 
on my Android development workstation to bring it to a fully functioning content production workstation 
capability, for both Android (Java 6 and Eclipse) as well as HTML5 (Java 7 and NetBeans) work.

In the Select a Destination and Extract Files dialog shown in Figure 1-6, place your cursor before 
the adt-bundle-windows part of the file name and then backspace over the Downloads folder. We 
are doing this because we do not want to install our development environment in our Software 
Downloads folder but rather under an Android folder in our primary hard drive, which is designated 
as C:\Android, and thus a resulting installation folder path would be C:\Android\adt-bundle-
windows-x86_64 as shown in Figure 1-6. Once your installation folder has been specified, click the 
Extract button.
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Once you click Extract, you will get a progress dialog, shown in Figure 1-7, showing 480+ 
megabytes of archived files being extracted into over 1000MB of data, spanning more than ten 
thousand items, in dozens of folders and subfolders.

Figure 1-6. Edit Install Folder to place it in the C:\Android\ folder that you created under your C:\ HDD root dir

Figure 1-7. Installing the Android ADT Bundle to your C:\Android\ folder showing progress dialog at 3% and 78%

Once everything is extracted, which may take a little while depending on the data access (and write) 
speed of your hard disk drive and the computer processor speed as well, we’ll be ready to create a 
shortcut for Eclipse.

Once this extraction process is completed, open your operating system file management utility; for 
Windows this would be called Windows Explorer, and is shown in use, in Figure 1-8. As you can 
see I have installed the latest Android OS 4.4 right next to the Android 4.2.2 OS that I used to write 
the Pro Android Graphics title earlier in 2013, as well as much of this title.
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We need to locate our adt-bundle-windows-x86_64-20131030 folder as well as its subfolders, 
in your root C:\Android\ hard disk drive in the left side of the Explorer utility, in the hard disk drive 
navigation pane.

Find your eclipse sub-folder where your application icon is located. This is located under your  
adt-bundle-windows-x86_64-20131030 folder, and then click it. This shows the contents (files and 
sub-folders) for this particular folder, in your file management pane, located on the right side of 
your Windows Explorer (or other OS file management utility).

Find the eclipse.exe program executable file; it will have a purple sphere (program icon) on the 
left side of it, as shown in Figure 1-9. Right-click this eclipse executable file, and select the Pin to 
Taskbar option from the context sensitive menu, which is brought up via your right-click.

Figure 1-8. Showing the ADT Bundle for Android 4.4 (20131030) next to an ADT Bundle for OS 4.2.2 (20130219)

Figure 1-9. Find the C:\adt-bundle-windows install folder and right-click the eclipse.exe file to Pin to Taskbar
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Once you select the Pin to Taskbar option, a single-click Eclipse software launch icon is installed on 
the operating system Taskbar, so that you can quickly and easily launch the Eclipse ADT software 
anytime you want to develop Android 4.4 applications.

It is important to note that we did not need to install quick launch icons (shortcuts) for Java 6u45, 
as the JDK that we installed exists underneath the other application development tools, and is not 
accessed directly, as the other open source software packages we are going to be installing are.

Java SE is a development environment infrastructure component, and is thus not directly accessed, 
or run, like Eclipse ADT or like other new media software development tools, which we’ll be installing 
a bit later on.

We’ll be creating launch icon short-cuts for these tools as well on our OS Taskbar so that we can 
quickly and easily launch them at a moment’s notice!

Figure 1-10 shows a Windows Taskbar with your quick launch icons installed with key system 
utilities (Character Map, Calculator, Notepad, Explorer), as well as some of the apps that we are 
going to install in this chapter, including Eclipse ADT, Pencil, GIMP, Lightworks, Blender 3D, and 
Audacity (Digital Audio Editing). Why do you need audio for UI Design? You may want to create 
audio feedback effects for button click or app background music.

Figure 1-10. Windows Taskbar shows the applications and utilities we are installing in this chapter

Figure 1-11. Loading Android Developer Tools and the Workspace Launcher dialog showing Workspace folder

Now we are ready to launch the Eclipse ADT IDE, and to make sure that we have all the very latest 
plug-ins, APIs, tools, and utilities installed.

Android ADT Bundle: Launch the IDE and Update the ADT
When you click the quick launch icon, you will see the ADT start-up screen and Loading Workbench 
progress bar, as well as a Workspace Launcher dialog allowing you to set-up your \workspace 
folder, as shown in Figure 1-11.
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On first launch Eclipse ADT may ask you for permission to use the software usage data to help them 
improve their product. I said Yes but you can also say No if you wish. When Eclipse starts for the first 
time, you will see a Welcome! screen, allowing you to create a New Android Application or to go 
through tutorials, such as Build Your First App, Design Your App, and Test Your App, as is shown in 
Figure 1-12.

Figure 1-12. On first launch of Eclipse ADT you will see a Welcome! screen which can be exited using the X icon

Click the X (or cross) in the Android IDE tab, at the top of this Welcome! screen to close this and 
show the Eclipse ADT IDE, which is initially empty. Your IDE contains the functional panes, but no 
project files or data, as shown in Figure 1-13. The left pane is the Package Explorer, and is used for 
project hierarchy navigation, the middle pane is your editing pane, and the right pane is the Outline 
pane for getting a bird’s-eye view of the project. The bottom pane contains Problems, Errors, and 
LogCat tabs.

Figure 1-13. Use the Eclipse ADT Help menu on first launch to Check for Updates to the IDE, plug-ins, API tools
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Once your Eclipse IDE has started up, select the Help ➤ Check for Updates menu sequence, as is 
also shown in Figure 1-13. This goes out over the Internet to the Eclipse software repository and 
checks for version updates.

It is important to note that for this to work properly, you must have an active connection to the 
Internet. If you do, Eclipse will open the Contacting Software Sites dialog, shown in Figure 1-14, 
and check the Eclipse software repositories for more recent versions of the software. A software 
repository is a directory on a remote server that contains the very latest software revisions, in this 
case, of the Eclipse Kepler IDE.

Figure 1-14. Checking for updates to the Eclipse Kepler IDE

Figure 1-15. No updates to the Eclipse IDE were found

In this case, we already have the latest version of Eclipse, which is to be expected, since we just 
downloaded and installed the ADT Bundle, and thus you should receive the “No updates were 
found” Information dialog.

This dialog can be seen in Figure 1-15, and informs you that no new updates for the Eclipse ADT 
IDE (Integrated Development Environment) have been found, which is to be expected, but we’ll just 
make sure anyway!

Now that you have checked for updates to the Eclipse IDE, you will use the Window menu and its 
Android SDK Manager option, to take a look at what you have just installed on an API component 
basis, as is shown in Figure 1-16.
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Figure 1-17 shows this entire Android SDK Manager dialog, as well as the Eclipse-installed (default) 
check selection next to the Google USB Driver.

Figure 1-16. The Android SDK Manager, invoked using Window ➤ Android SDK Manager

Figure 1-17. Android SDK Manager dialog and the components you just installed; select the Google USB Driver
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Click the Install 1 package button, to install this Google USB Driver, so that you can test your 
Android apps on real Android hardware devices. You can also select other Google APIs in this area 
of the dialog if you needed to use any of these in your application development as well.

Once you click this button the Choose Packages to Install dialog will appear, as can be seen in 
Figure 1-18, where you can see all of the various packages that you have selected for installation.

Figure 1-18. Accepting the license terms and conditions for the Google USB Driver

Figure 1-19. The Google USB Driver download progress bar located at the bottom of the dialog

Once you click the Accept radio button to accept the license agreement, and then click the 
Install button, you will get the progress bar at the bottom of the Android SDK Manager dialog, 
shown in Figure 1-19, that shows which package is being downloaded, the revision, the percentage 
completed, the data transfer speed, and the time left until the download’s completion.

Once the download of the Google USB Driver is complete, this progress bar will turn grey once 
more, and a Done loading packages message will appear.
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Notice in Figure 1-20 that the Google USB Driver is now showing inside your Android SDK Manager 
dialog as being installed, and is also showing a version number (8) so that you know what version 
you have installed.

Figure 1-20. Done loading packages message, and showing the Google USB Driver as Installed

Now that you have Android ADT for KitKat 4.4 installed, let’s install some other useful open source 
software packages that we may want to use during the book, and for your Android development 
endeavors in the future.

UI Wireframing Tool: Downloading and Installing Pencil
Since this is a Pro UI book, we’ll download the leading open source user interface wireframing tool, 
called Pencil 2.0.5, as shown in Figure 1-21.

Figure 1-21. Going to the pencil.evolus.vn website homepage to download Pencil 2.0.5 for Windows
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Go to pencil.evolus.vn or simply Google “Pencil Wireframe Tool,” and click the orange download 
button on the homepage. Once the file is downloaded, launch the installer and review the license 
agreement as shown in Figure 1-22, and then click the I Agree button, to accept the licensing 
agreement. Then click the Next ➤ button, and accept a default installation folder, by clicking on the 
Next ➤ button again, in the third dialog.

Figure 1-22. Setting up Pencil 2.0.5; agree to the license agreement, choose installation location for the software

Figure 1-23. Choosing your Start Menu Folder, Installing the software, Launch Pencil 2.0.5 to make sure it runs

Next accept the default Start Menu Folder and click the Install button, which brings up the 
installation progress dialog shown in Figure 1-23. If you want to see details regarding the install, click 
the Show Details button. When the installation is finished be sure that the Launch Pencil checkbox 
is checked and the software will launch so that you can make sure that it works on your system.

When the software launches, you should see a blank wireframe design area on the right side 
and several stacked palettes of wireframing tool icons on the left side of the screen, as shown in 
Figure 1-24.
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The first section common shapes might be better suited for creating flow-charts than user interface 
designs, but there are some icons in that group that might be usable for basic UI Design. The 
second group is targeted at basic HTML website design UI elements, and the third section is 
targeted at UI design for Linux GTK desktop UI programmers. The fourth section is native UI design 
desktop widgets for OSes such as Windows and Macintosh.

Let’s take a look at the user interface design widgets for the Android 4.0 ICS section of Pencil, 
before we exit the software and continue installing our other open source software packages that we 
will use for UI Design.

Grab the scrollbar handle, shown on the right side of the Pencil User Interface widget collections 
pane in Figure 1-24, and drag it halfway down to the center (or middle) of the slider bar range.

You will see the section come into view labeled Mobile Android ICS and that contains Android 4.0 
UI widgets, which we will be using later on in the book in the chapter on UI design and wireframing 
techniques.

Currently, there are almost 80 different UI widgets we can drag and drop on the right side of the 
screen to prototype UI designs, as shown in Figure 1-25. We’ll be learning about many of these 
UI widgets in Chapter 3 of this book on the View class, which is used to create subclasses in 

Figure 1-24. Launching Pencil 2.0.5 to make sure it runs; taking a look at the flowcharting shapes and UI widgets
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the android.widget package. These classes are instantiated as objects, are then implemented as 
functioning user interface elements. It is also important to note that you can import Android 3.0 style 
UI widgets into Pencil if you want to design via an Android 3.0 UI Design appearance.

Figure 1-25. Scrolling down to the Android 4.0 ICS Mobile UI Design widget section that we are going to utilize

Next we need to download and install the professional digital imaging software called GIMP 2.8.10, 
which is similar to the popular Photoshop digital imaging software package except that it’s free for 
commercial use.

Digital Image Editing: Download and Install GIMP 2.8.10
Digital Image Editing software is important for Android development, as well as for User Inferface 
Design. The reason for this is that Android allows developers to integrate their own graphic elements 
into the Android widgets by referencing an image source, using a background image, or using an 
alpha value (transparency).

Alpha channels, which we’ll be learning more about later, are an attribute of the UI element, which 
will allow digital image assets to “show through” the User Interface element. This allows a UI element 
to be integrated into the overall application’s “User Experience” with 100% seamless results.

Open your browser and go to www.gimp.org. You are taken to the GIMP homepage, shown in 
Figure 1-26.

http://www.gimp.org/
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You could also use Google and the search term “GIMP 2” if you prefer. Once you’re on the 
GIMP homepage you can then click on their Downloads link, or the Download button, to visit the 
Downloads page, as shown in Figure 1-27.

Figure 1-26. Go to the www.gimp.org website homepage, and click the Download button, or Downloads link

Figure 1-27. Downloading GIMP 2.8.10 for Windows XP SP3 or later from the www.gimp.org/downloads/ page

http://www.gimp.org/
http://www.gimp.org/downloads/
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Once GIMP 2.8.10 is downloaded launch the installer executable and accept the license agreement 
and default installation locations and parameters.

If you like you can follow the same work process that we did with Eclipse and place a quick launch 
short-cut icon on your Taskbar by right-clicking the GIMP 2.8.10 icon, and selecting Pin to Taskbar. 
You can reposition launch icons by dragging them into any position you prefer on the Taskbar.

Next, let’s go and get the leading open source 3D software, Blender 2.69, which is available for 
Windows, Linux, and Macintosh in both 32-bit and 64-bit versions. Blender updates its software 
monthly, and, for that reason, by the time you read this, version 2.70, or even 2.80, might be 
available!

3D Modeling and Animation: Download and Install Blender
Next we will need to download and install the professional 3D modeling and animation software 
called Blender 2.69, which is similar to the popular 3D software packages out there such as 3D 
Studio MAX, Maya, Cinema 4D, and Lightwave, except that it’s completely free for commercial use.

3D modeling, design, rendering or animation software can be very useful in Android development, 
as well as for User Interface Design, because it allows you to create “out of thin air” what is in your 
head as a designer.

Since the Android OS allows developers to integrate their own UI graphics design elements into 
the Android OS, having a professional 3D tool such as Blender 3D 2.69 on your Android app 
development workstation is important.

Go to www.blender.org, or Google “Blender 3D,” and when you get to the website (as shown in 
Figure 1-28), click the blue Download Blender 2.69 button on the right side of the page.

Figure 1-28. Going to the www.blender.org website homepage, and then clicking on the blue Blender 2.69 button

http://www.blender.org/
http://www.blender.org/
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Once you do this you’ll be taken to a “Download Blender” page, which has Blender versions for a 
plethora of different operating systems, including Windows, Macintosh, Linux, and Unix.

Since my operating system is Windows 8.1 64-bit, I downloaded the 64-bit version for Windows, as 
shown in Figure 1-29, at the bottom of the screenshot in the dark blue area.

Figure 1-29. Downloading Blender 2.69 for Windows 64-bit or 32-bit from the www.blender.org/download/page

I chose the .EXE installer version, because it was easier to install than a ZIP and smaller in filesize, 
resulting in a faster download.

Once your installer file has been downloaded, launch it, and install this impressive 3D software 
package, using its default settings.

If you like, you can follow the same work process that we did with Eclipse and place a quick launch 
shortcut icon on your Taskbar by right-clicking the Blender 2.69 icon and selecting Pin to Taskbar. 
You can reposition launch icons by dragging them into any position you prefer on the Taskbar.

Next, let’s download the leading open source Digital Audio software package, Audacity 2.0.5, which 
is available for Windows, Macintosh, Linux, and other operating systems, in a 32-bit format version.

Digital Audio Editing: Downl oad and Install Audacity 2.0.5
The Audacity project is hosted on sourceforge.net, an open source software development website, 
which you might find extremely interesting, to search for software that interests you if you didn’t 
know about the site already, that is!

http://www.blender.org/download/page
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To reach the Audacity project, go to the audacity.sourceforge.net URL, and you will see the 
Download Audacity 2.0.5 link, shown in Figure 1-30.

Figure 1-30. Going to the audacity.sourceforge.net website page and clicking the Download Audacity link

Notice that the 32-bit Audacity supports decades-ancient operating systems such as Windows 
2000, well over a decade old, and Windows XP, now almost a decade old. I am hoping that you 
are using either a Windows 7 or a Windows 8 operating system for your Android development 
workstations, as these newer two OSes, especially Windows 8.1, which at this point is now almost 
as memory efficient as Linux OSes are.

Once your Audacity installer file has been downloaded, you can launch it, and proceed to install this 
feature-filled digital audio editing software.

The first thing that it will ask you is in what language you want to run the software, I selected the 
default, English, as is shown in Figure 1-31.

http://www.blender.org/
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Then I clicked the Next button and read the information given and then I clicked the Next button 
again, accepted a default installation location, as shown in Figure 1-32, and Created a desktop icon, 
in the next dialog.

Figure 1-31. Selecting an installation language, starting the Audacity installation, reading the licensing agreement

Figure 1-32. Selecting Install Location, Creating a desktop icon and beginning the installation process

Figure 1-33. Extracting installation files, reviewing open source information, finishing the install, and launching Audacity

Finally, I clicked Install, and got the Installing progress bar dialog, as shown in Figure 1-33, as well 
as more information regarding the Audacity project, and a final dialog where I could click the Finish 
button to exit the installer software. Now that Audacity 2.0 is installed, we can launch the software, 
and make sure that it’s working on our system.


